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Chapter One 

INSTALLING THUNDERSCAN GS 

How To Use This Guide 
This guide assumes that you are familiar with the Apple IIGs. You should 
know how to use the mouse, open applications and documents, select 
pathnames and directories and use the Finder. For more information, 
please refer to your Apple JIGS Owner's Guide. 

Before using this manual, you should first read the Introduction and 
Chapter One of the ThunderScan User's Guide. This will help you install 
your scanner and prepare your printer for scanning. The section Config
uring ThunderScan for Your Printer does not apply to the ThunderScan GS 
software. 

After you've installed the ThunderScan scanning cartridge, prepared 
your printer and inserted the tutorial image, you'll be ready to read this 
manual. 

To use ThunderScan GS: 
• Chapter One of this guide explains how to set up and configure the 

ThunderScan GS software. 
• Chapter Two, Learning ThunderScan GS, gives you all the informa

tion you'll need for using the scanner and software. 
• Chapter Three, Playing with ThunderScan GS, contains everything 

you'll need to manipulate and print your images. 
• Also, if you want to learn more about getting the best results from 

your scanner or if you are having problems, you'll want to read 
Chapter Four, Reference, of the ThunderScan User's Guide for more 
details. 

About ThunderScan GS 
The ThunderScan GS software has been created specifically for use on 
the Apple IIGS with at least 512K of memory. You can use your mouse to 
access menus, select scan areas, change contrast and brightness, create 
negatives and colorize images with up to sixteen different colors. You 
can print scanned images with an ImageWriter® or LaserWriter®. 
Images can be saved in a variety of formats and changed later in pro
grams like: AppleWorksTM GS, DeluxePaint™ II, Paintworks™ Plus and 
Paintworks Gold. 
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Using Scan Files from 
Other Versions of ThunderScan 
Other versions of ThunderScan were designed for the Apple lIe and IIc, 
as well as the IIGS. The lIe and IIc use a different display format from the 
Apple IIGs. ThunderScan GS will load all ThunderScan files, but some in
formation will be changed in the process. Specifically, you may need to 
use the Filter to adjust the colors or gray shades. The filter is described in 
Using the Filter in Chapter Three. You may also notice a slight difference 
in using files created with other versions while scrolling horizontally. 
This is because some of the screen formats available on the lIe and IIc are 
of different widths (aspect ratios) than the ThunderScan GS screen. If 
you plan to continue using another version of ThunderScan software you 
should create a separate ThunderScan image file for ThunderScan GS 
using the system finder's duplicate function. 

Making a Backup Copy 
Before scanning, you'll want to use a utility program to make a backup 
copy of the ThunderScan program disk. Use the backup copy of the 
software when setting up your system and store the original in a safe 
place. 

Setting Up Your System 
The ThunderScan GS application comes on a disk ready to use, but you 
may want to move files around and use your own system files to cus
tomize it for the equipment you have. ThunderScan GS saves images 
directly to disk during scanning. If you have a large amount of disk 
space available you will be able to scan larger areas and at higher 
resolutions. 

Deciding between GS/OS and ProDOS 16 
If you have 768K or more of memory, you should use GS/OS version 4.0 
or greater. GS/OS is much faster than ProDOS 16. GS/OS is not included 
on the ThunderScan disk, but is available from your local authorized 
Apple dealer. If you only have 512K of memory, you'll have to use Pro
DOS 16. 
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Configuring ThunderScan GS with GS/OS 
The disk included in this package does not include the GS/OS system 
files. Consequently, you will have to create a GS/OS startup disk to use 
with ThunderScan GS. To create a GS/OS startup disk with Thunder
ScanGS: 
1) Boot your Apple IIGS using a copy of the GS/OS system disk. 
2) Use the Installer to add any other system files that you may need. 
3) Insert the backup copy of the ThunderScan program disk. 
4) Make a new folder on the copy of the GS/OS system disk. 
5) Copy all the files from the folder THUNDERSCAN.GS into the new 

folder. 

Important Note: It is important to keep ThunderScan GS files in the same 
folder (directory). If one file is missing or in another directory, the ThunderScan 
GS will not operate properly. 

If you're using ThunderScan GS with GS/OS and a hard drive, follow 
steps 3 through 5 above, copying files to the new folder on your hard 
drive. 

Configuring ThunderScan GS with ProDOS 16 
The disk included in this package comes ready to use with ProDOS 16. 
To create more disk space for images, you may wish to use a separate 
boot disk: 
• Use any disk utility program to delete the files: PROooS and the 

THUNDERSCAN folder, from a backup copy of the ThunderScan 
program disk. 

• Rename the file PRODOS.GS - ''PRODOS.'' 

If you're using ThunderScan GS with ProDOS 16 and a hard drive you'll 
want to follow steps 3 through 5 in the section above, Using ThunderScan 
GS with GS/OS , copying the files to your hard drive. 
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Chapter Two 

LEARNING THUNDERSCAN GS 

Take a moment to familiarize yourself with Chapter One, Installing 
ThunderScan, in the ThunderScan User's Guide. At this point you should 
have your scanner properly installed and your printer prepared for scan
ning. 

Inserting an Original 
For purposes of learning, you'll want to put the tutorial image (the 
picture of the train) supplied with the ThunderScan package into your 
ImageWriter. To insert an original: 
• Tum your printer off and remove all paper. 
• Set the release lever to the friction feed position and roll in the tutorial 

image (Insert the original so that it is facing toward you when you 
roll it through the printer). 

• After the original is in the printer, set the release lever to the pin feed 
position. 

• Align the left edge of the original with the platen (the platen is the 
big roller that the paper goes around). 

• Set the release lever to the friction feed position. 
• If you have an ImageWriter I or Wide-carriage ImageWriter, move 

the paper bail (sometimes called the roller shaft) toward you, away 
from the platen. 

• If you have an ImageWriter II, push the paper thickness lever all the 
way down (allowing for maximum paper thickness). 

• If you have an ImageWriter I or Wide-carriage ImageWriter, push 
the paper bail back against the platen. 

Now that your original is in the printer, you're ready to scan. 
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Launching ThunderScan GS 
Before launching ThunderScan GS, be sure that you're using a copy of 
the software (not the original disk). Also, make sure Printer Buffering is 
disabled in the lIes Control Panel. ThunderScan will not operate prop
erly with printer buffering. Thunder5can GS is the startup application, so 
it will automatically load when you boot your computer. If you're using 
a hard drive, launch ThunderScan GS just as you would any other 
program. 

The screen will look like this: 

.; file Edit Scanner 

ThunderScan liS 1.0 

By Tracy Ualleau at data Smith 

Driuer by Tom Petrie and Doug Penney 

Copyright 1989 Thunderware, Inc. 

Figure 2-1: The ThunderScan GS window. 

Click on the OK button (or press Return) to proceed. 

Important note: If you experience problems while running the Thunder
Scan GS software, do not re-boot your computer while disk access is 
occurring. Doing so can damage the disk or directory being used. Wait 
until disk activity has stopped, then eject all disks (if you're using floppy 
disk drives) and re-boot your computer. 
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Configuring the Software 
To configure the software for your printer and start a new scan, select 
New Scan from the Scanner menu (or press 0- N). The scan screen 

appears: scan rectangle 

.; file Edit 

FORMAT QUAL lTV 
@ Super Res @ High 

a Ultra Res a Normal 
MODE EDGE 

@ Color @ Smooth 

a Line art a Rough 
Blocks Req'd: 121 
Blocks Avail: 134 

DP I: 1 4410 Immmmmf]immmmil91 
Prefix: 

5 

6 

7 

8 

9 

@ ImageWriter II OlmageWriter I 10 

[SUm] Cancel 
11 

Figure 2-2: The scan screen. 

view rectangle 

1234567 

The settings shown in the figure above are standard, but can be changed 
depending on your original, the file format you want to create and the 
type of printer you have. All of the settings are saved automatically 
when you quit the program. The rest of this section explains how each 
option works. 
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Format 
ThunderScan GS allows you to scan in both the Super Res and Ultra Res 
formats. The super res format displays scanned images in 16 levels of 
gray scale or colors. The ultra res format displays scanned images in only 
4 levels of gray, but has twice the horizontal resolution of super res. For 
purposes of learning ThunderScan GS, use the Ultra Res format. That's 
because the tutorial image is line art: all black and white with no grays or 
colors. 

Quality 
There are two choices for scan quality: Normal and High. Normal 
quality provides a standard quality scan image. High quality gives a 
slightly higher quality image, but scanning takes longer. For purposes of 
learning ThunderScan GS, select High. 

Mode 
The Mode determines how an image will appear on the screen. Depend
ing on the format setting, you can choose from two modes: Color and 
Line art. The color mode is best for scanning continuous tone originals 
like photographs. The line art mode displays images in high contrast-all 
black and white with no grays. Lighter shades of gray become white and 
darker shades of gray become black. The line art mode is only available 
in the ultra res format. For scanning the tutorial image included in this 
package, select Line art. 

Edge 
The edge setting refers to the quality of the left edge of the original being 
scanned. The Smooth option should be used when scanning originals 
that have clean, straight white left margins of at least 1/4-inch along the 
area to be scanned. The smooth option increases scanning speed. If your 
original does not have a clean, white left margin of at least 1/ 4-inch or if 
it is printed on colored paper, you should use the Rough option. For 
scanning the tutorial image, choose the Smooth option. 

DPI (Resolution) 
Magnification is measured in dots per inch (DPI), as shown on the DPI 
scroll bar. DPI refers to the number of dots in each horizontal line used 
to represent an inch of the original. A DPI of 100 means that 100 dots on 
the screen represent one inch of the image being scanned. ThunderScan 
GS allows you to select up to a maximum resolution of 350 DPI down to 
a minimum of 36 DPI. 
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DPI is adjusted in three ways: 
• Clicking on the arrows of the scroll bar. 
• Moving the scroll box along the scroll bar. 
• Clicking on the gray area of the scroll bar. 

As DPI changes, so does the amount of Blocks Req'd for ThunderScan 
GS to save the scan file. As DPI increases, the scan file becomes larger 
and more blocks are required to store the scan file. The blocks required 
should be less than the Blocks Avail. 

To scan at original size in the super res format, set the DPI to 40. To scan 
at original size in the ultra res format, set the DPI to 80. For purposes of 
learning ThunderScan GS, select 125 DPI. 

Prefix Selection 
ThunderScan GS saves scanned images on disk during scanning. The 
Prefix Selection allows you to save images to different volumes or 
directories. If you are not sure of a the pathname, a blank prefix selection 
will save the image to the directory where the ThunderScan GS applica
tion resides. To change the prefix selection: 
• Use the mouse to select the pathname in the prefix selection box. 
• Type in the pathname of the directory that you want to save the 

image to, (or leave the prefix selection blank to save to the directory 
that contains ThunderScan GS). 

• Click on the words "Blocks Avail." to view the disk space available 
for scanning. 

Printer Selection 
ThunderScan works with the ImageWriter I, Wide-carriage ImageWriter 
and ImageWriter II. If you are using a Wide-carriage ImageWriter, you 
should select ImageWriter I. Clicking on the appropriate button tells 
ThunderScan which printer to expect. ThunderScan can scan a maximum 
of a 7-3/4 X 11 inch area regardless of which ImageWriter you are using. 
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Selecting an Area to Scan 
The page on the right side of the new scan screen is called the page map. 
The page map represents the original in the printer. The black rectangle 
inside the page map is called the scan rectangle. The scan rectangle tells 
ThunderScan where to start and stop scanning. To change the size of the 
scan rectangle: 
• Using the mouse, move the pointer to the lower right handle in the 

corner of the scan rectangle. 
• Hold down the mouse button and move the mouse to reduce or 

enlarge the rectangle's size. 

To move the scan rectangle: 
• Using the mouse, position the pointer on the upper left tab of the 

scan rectangle. 
• Hold down the mouse button and use the mouse to move the scan 

rectangle about the page map. 

The rulers on the page map show the area selected in inches. The green 
rectangle, the view rectangle, shows how much of the scanned image 
can be seen on the screen. This feature can be very helpful for creating a 
screen-sized image for use in a painting program. 

For the tutorial image, select an area that is approximately 6 inches wide 
and 4 inches tall as shown in Figure 2-3. 

234567 
, , 

~~ I 
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8-
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II 

Figure 2-3: Proper position and size for area to be scanned. 
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Focusing the Scanner 
Once you have selected and positioned the scan rectangle, be sure your 
printer is off. Click on the Scan button. A dialog box appears with focus
ing instructions. 

1 - Make sure your printer is OFF. 

2 - Pos itio n the sea n ner over the wh itest area to be sca n ned. 

3 - Turn the scanner's focus knob until the number is as high 
as possible without going over 60. 

4 - Click on "OK" to accept the number & proceed, 

5 - or click on "Skip'· to use the previous focus number. 

Focus: 46 Previous Focus: 17 

[®1 ( SkiP) ( Cancel 

Figure 2-4: The focus dialog box. 

Focusing puts the lens of the scanner in the right position for scanning. 
Proper focusing is critical to get a full range of shades in every image. Look 
between your original image and the scanner: you can see a red light 
shining onto your original. The light reflects off the document and is 
recorded by the scanner. 

Focusing is easy. Simply follow the instructions in the focus dialog box. 
Grasp the print head assembly of the printer-not the scanner itself to 
move the scanner. Focus on the lightest part of the area to be scanned, 
(which may not be the lightest area of the page). Use your finger to 
gently roll the focus knob back and forth until the focus number on your 
screen is as high as it will go. The exact number varies from scanner to 
scanner and from original to original. Don't worry if the focus number 
flickers a bit. 
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Your focus number should be between 30 and 60. If the number is 
greater than 60, use the focus knob to bring the number down to 60. Be 
sure the number is not above 60 before continuing to the next step. 
ThunderScan GS saves the focus number. To continue: 
• Click on the OK button (or use the previous focus number by 

clicking on the Skip button). 

Scanning an Image 
Mter focusing, the printer setup dialog box appears: 

1 - Be sure the printer is OFF. 

2 - Replace the cover (or key on the ImageVtfriter I). 

3 - Turn the printer ON. 

4 - Be sure the "Select" light is on. 

S - Click on OK to proceed. 

( cancel) 

Figure 2-5: Dialog box for replacing the printer cover or scan key. 

Be sure to follow the instructions on the screen. To proceed, click on the 
OK button. Clicking on the Cancel button exits the scanning sequence. 
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Mter clicking on the OK button in the printer setup dialog box, another 
dialog box for adjusting the original will appear: 

1 - Ro II the orig i na I up or down so that 
the scanning will begin in the desired 
position. 

2 - Do not move the sea n ner or turn 
off your printer. 

3 - Click "Begin Scan" when ready. 

n Begin scan' ( Cancel 

Figure 2-6: Dialog box for adjusting the original. 

If you are using an lmageWriter II, the printer will go through its normal 
startup routine. Make sure the scanning light is shining through the hole 
in the plastic paper guide. Use the red line on the paper guide as a 
reference for adjusting your original. The red line indicates where 
scanning will begin. After positioning the original, click on the Begin 
Scan button. 
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ThunderScan GS will create a scan window and the scanner will move 
back and forth, scanning the image line by line. After a few minutes, the 
image will begin to fill your screen and look like this: 

@; File Edit 

Figure 2-7: The scan in progress. 
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Using the Mouse During Scanning 
Usually you won't have to use the mouse during scanning. If you do, 
you'll notice that the pointer doesn't move easily. That's because scan
ning is a very intensive procedure that requires most of the processing 
power of the Apple IIGs. 

Pausing/Stopping the Scan 
To pause or stop the scan, press the cJ key. A pause dialog box appears: 

Quit scan or pause? 

Use Resume Scan from the Scanner menu 
to continue from pause. 

K Resume l (Quit scan) Pause) 

Figure 2-8: The pause dialog box. 

Clicking on the Pause button will exit the pause dialog box, allowing you 
to move your mouse and make changes to contrast and brightness. After 
pausing, select Resume Scan (or press cJ- R) from the Scanner menu to 
begin scanning again. Clicking on the Quit Scan button will stop the 
scan. Clicking on the Resume button will exit the pause dialog box and 
continue scanning. 
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Chapter Three 

USING THUNDERSCAN GS 

Playing with ThunderScan GS 
After you've finished scanning an image (or opening an image from 
disk), you can move the image around to see more of it, adjust the 
contrast and brightness, add colors, save and print it. 

Scrolling 
You can scroll an image that is larger than the window-right or left, up 
or down. To scroll: 
• Move the pointer onto the arrows of either the vertical or horizontal 

scroll bars of the image window. 
• Click the mouse button to move in small increments. 
• Slide the scroll box to move in larger increments. 

When you release the mouse button, ThunderScan GS pauses to refresh 
the screen by reading a new section of the image from disk. 

The Clipboard 
Copy copies a selected part of an image to the Clipboard. The Cut and 
Paste commands do not work and will always be dimmed. An image 
copied to the Clipboard will not retain its contrast, brightness and filter 
settings. 

To copy an area to your Clipboard: 
• Choose Copy from the Edit menu (or press 0- C). The pointer ( ..... ) 

changes into a cross bar (+). 
• Move the cross bar onto the image area. 
• To select a portion of the image, hold down the mouse and drag the 

cross bar over the portion of the image you desire (the maximum 
area that can be copied is a single screen). 
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Changing Contrast and Brightness 
ThunderScan's contrast and brightness controls are similar to the con
trols on a television set. The brightness control makes the image lighter 
or darker. The contrast control alters the range of grays in an image. 
When contrast is increased, dark grays become black and light grays 
become white. Contrast and brightness settings affect the entire image. 

To adjust the contrast and brightness of your image: 
• Select Contrast & Brightness ... from the Scanner menu 

(or press Q- B). 

The contrast and brightness scroll bars appear on screen: 

100 o 

IIII~' 

C B 

~ 
( Cancel J 

Figure 3-1: The contrast and brightness controls. 

The standard settings are 0 for brightness and 100 for contrast. To change 
the contrast and brightness: 
• Use the mouse and click on the arrows or drag the scroll box of the 

brightness and contrast scroll bars. 

Notice the changes to the image? Click on the OK button when you have 
reached the satisfactory settings. Or, click on the Cancel button (or press 
Return) if you wish to cancel your changes. 
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Protect Controls 
Changes to contrast and brightness affect the entire screen, including the 
menus, windows and all other controls. This means that it is possible to 
make the controls disappear if extreme changes are made to contrast and 
brightness settings. To guard against this, ThunderScan GS comes with 
Protect Controls turned on. If Protect Controls is turned off, you may 
notice that when the brightness or contrast controls are adjusted to either 
extreme, the screen may turn completely black or white. Don't panic. 
Press the Return key to exit the contrast and brightness controls and 
return to the image window. However, brightness and contrast settings 
will not affect the absolute black and white pixels of an image when 
protect controls is turned on. 

Using the Filter 
The Filter allows you to create a multitude of special effects. You can 
create negatives, add color, or simply view the percentage of grays that 
make up the image. 

To use the filter: 
• Select Filter ... from the Scanner menu (or press Q- F). 

The filter dialog box appears: 

(% gray) 

10 5 9 
:; o 4 

( Accept J 

Filter 

8 2 
7 

Reset 

Figure 3-2: The filter dialog box. 

6 11 o 
8 5 17 

Cancel 
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There are three palettes: gray, mixing and color. The top palette shows 
the 16 possible shades of gray. The numbers at the top of the gray palette 
show the percentage of each shade present in the screen currently being 
viewed. The percentages of gray values will serve as a reference when 
using the color palette. 

The mixing palette lets you combine gray values from the gray palette 
and colors from the color palette to change an image. Shades or colors 
are dragged from the gray or color palettes onto the mixing palette. Here 
are a few ideas: 
• To invert an image, reverse the order in the mixing palette. Drag 

grays from the gray palette onto the mixing palette so white is repre
sented by black, black by white, and so on. 

• To posterize an image, copy one shade to three or four shades in the 
mixing palette. The end result is an image that has fewer levels of 
gray. 

Try it for yourself. When you feel you have achieved a desired effect, 
click on the Accept button to view the image. You can revert to the 
standard the gray palette by clicking on the Reset button in the filter 
dialog box. 

In the ultra res mode, the mixing palette consists of four mini palettes 
with four entries in each. Changes made to one mini palette affect all 
mini palettes. 

The black and white values in the mixing palette will affect the menus, 
windows and all other controls. Consequently, you should never set 
black and white to the same value. Otherwise, menus and commands 
will become invisible. If protect controls is turned on, you will not be 
able to alter the black and white values in the mixing palette. If you make 
your controls invisible, simply press 0- F to return to the filter screen 
and correct the palette. 
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Switching Display 
ThunderScan GS allows you change the format and mode after scanning 
an image. To change format or mode: 
• Select Switch Display ... from the Scanner menu. The switch display 

dialog box will appear: 

Switch Display to ... 

Format 

@ Super Res 

o Ultra Res 

n Rccept » 

Mode 

@ Color 

o Line Rrt 

Cancel 

Figure 3·3: The switch display dialog box. 

Use the mouse to select the desired settings. You can change the format 
from super res to ultra res or switch modes from color to line art. Line art 
mode is only available in the ultra res format and will be dimmed when 
super res is selected. Click on the Accept button to view your changes. 
Click on the Cancel button to ignore the changes and return to the image 
window. 
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Saving Scanned Images 
After you have finished playing with your image, you may wish to save 
it. ThunderScan GS saves images in the popular file formats to allow 
them to be used with almost any program for the Apple IIGS that uses 
graphics. 

To save a scanned image: 
• Select Save As ..• from the File menu (or press 0- S). The scan file 

format box appears: 

Select Saue file-fOrmat 

Rpple GS paint: 
o Rpple-Preferred ($CO\2) 
o Single Screen ($C 1 \0) 
o Double Screen ($CO\O) 

ThunderScan: 
@ Scan file 

( cancel) 

Figure 3-4: The scan file format box. 

Saving as a ThunderScan File 
Saving as a ThunderScan file saves the entire image you've created. Scan 
files can be reloaded in the ThunderScan GS program so you can make 
changes to brightness, contrast, and the filter. Scan files are the only files 
ThunderScan GS can load. Be sure to keep a copy of your images as scan 
files in case you need to use them again. 
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Saving as Screen Files 
Screen files can be used with a variety of different programs, but they 
cannot be loaded into ThunderScan GS. Before saving an image as a 
screen file: 
• 

• 

Make sure the brightness, contrast, and filter controls are set to your 
liking. 
Use the scroll bars to position the image for saving. The area dis
played will be saved. 

The Apple-Preferred ($CO\2) file saves one screen of the image. It is a 
compressed file and takes up less space than the Single Screen file. The 
Apple-Preferred file is supported in programs like DeluxePaint II, 
Paintworks Gold, and AppleWorks GS. 

The Single Screen ($Cl\O) also saves one screen. It is an uncompressed 
file and will require 65 blocks on disk. Single screen files can be imported 
into almost any painting program. 

The Double Screen ($CO\O) saves two screens of an image, the screen 
being viewed and the one directly below it. It is a compressed file. 
Double screen files can be used in Paintworks Plus and Paintworks Gold. 

- Once you have decided on a file format: 
• Use the radio buttons to select your choice. 
• Click on the OK button (or press Return). Clicking on the Cancel 

button will exit the save dialog and return to the image window. 

After clicking on the OK button, another dialog box will appear: 
• Type in a filename. 
• Click on the Accept button (or press Return). 

ThunderScan GS saves the file to the prefix entered in the prefix selection 
of the scan screen. 
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Opening Images 
ThunderScan GS only loads scan files and will not load screen files. To 
load an image: 
• Select Open ... from the File menu (or press 0- 0). 
• Click on the Disk button to change volumes. 
• Select the file you want and click on the Open button (or press 

Return). ThunderScan GS loads the file. 

Printing with an ImageWriter 
ThunderScan GS allows you to print with an ImageWriter. This section 
explains how to print an image with the ImageWriter and the options 
available. 
• If you are using an ImageWriter II, adjust the paper thickness lever 

to the up position. 
• Use the scroll bars to position the image in the window to be printed. 

ThunderScan GS prints an 8 X 10 inch area from the upper left corner 
of the image being displayed. 

• Select Choose Printer ... from the File menu and select the desired 
printer. 

• Choose Print ... from the File menu (or press 0- P). 

The ImageWriter page setup dialog box appears with printing instruc
tions: 

I mageWriter /Printer 

Paper: @ US Letter 
o US Lel=lal 
o A4 Letter 
o International Fanfold 

Uertical Sizing: 
@ Normal 
o Condensed 

Orientation: 

Printer Effects: 

050 % Reduction 
o No Gaps Between 

Pages 

( cancel) [ OK J 
Figure 3-5: The ImageWriter page setup dialog box. 
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Normal should be selected for the Vertical Sizing option. Condensed 
will cause images to be compressed vertically in size. 50% Reduction 
should be used when you are printing line art images. Gray shade 
images will appear dark when printed at 50% reduction with an 
ImageWriter. 

After the page setup options are set to your liking, click on the OK 
button to proceed. The print dialog box appears with further printing 
instructions: 

I mageWriter /Prir:ter 

Quality: o Better TeHt 
@ Better Color 
o Draft 

Page range: @ All D D o From: To: 

Copies: 10\ 
Paper Feed:@ Automatic 0 Manual 

o Color ( cancel) [ OK n 

Figure 3-6: The ImageWriter print dialog box. 

• Better Color should selected as the Quality (Better Text and Draft 
are used for printing text). 

• If you have an ImageWriter II and a color ribbon, you'll be able to 
print your images in color. (You'll want to colorize your image using 
the filter palettes first). 

• Click on the OK button. 

Printing begins after a few moments. 

Stopping Printing Early 
To stop printing before the ImageWriter is finished: 
• Hold down the Command key and type a period. 

After a few moments, printing will stop. ThunderScan GS returns to the 
image window. 
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Printing with a LaserWriter 
If you have a LaserWriter available, you'll be able to print PostScript® 
halftones. Bef?re you begin you'll want to make sure your system is 
prop~rly confl~red for use with a LaserWriter. Since the ImageWriter 
reqmres the pnnter port, your LaserWriter should be connected to the 
modem port. To prepare your LaserWriter for printing: 
• Make sure the LocalTalk™ cable is connected to the modem port on 

your Apple IIes. 
• Enter the Control Panel and make sure it is configured for Ap

pleTalk in slot 7 and Your Card in slot 2. 
• Select Choose Printer ..• from the File menu. 
• Use the mouse to choose printer type (LaserWriter) and printer port 

(Modem). Click on the OK button. 

Choose Page Setup from the File menu. The LaserWriter page setup 
dialog box appears: 

LaserWriter 

Paper: @ US Letter 
o US Legal 

Orientation: 

o H4 Letter 
085 Letter 

Uertical Sizing: 
@Normal 
o Intermediate 
a Condensed 

Reduce or fiiiiiiil 
Printer Effects: Enlarge: ~ '0 
DSmoothing? ~ 
D Font Substitution? ( Cancel ) ~ 

Figure 3-7: The LaserWriter page setup dialog box. 

You can make changes to printed resolution and orientation through 
Page .Setup. The Vertical Sizing options are generally used for printing 
text fdes, but can also alter printed graphics. The Intermediate and 
Condense~ op~ons ~ll comp~ess images vertically. The Smoothing and 
Font SubstItutIon optIons are Ignored in ThunderScan GS. 
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The Reduce or Enlarge option controls the printed resolution and size of 
printed images. Use 100% to print the image at actual size as it appears 
on the screen. Use a 50% reduction to print an image that is half the 
length and width of the actual size (1/4 of the area) with twice the reso
lution. 

To print to the LaserWriter, choose Print •.• from the File menu (or press 
0- P}.The LaserWriter print dialog box appears: 

LaserUfriter 

Page: @ HII D 
o From: 

Copies: lal 
To:D 

Paper Source:@ Paper Tray 
o Manual 

( Cancel ) n OK » 

Figure 3.8: The LaserWriter print dialog box. 

• Set the number of copies and the paper source. 
• Click on the OK button. 

In a few minutes, your image will print. 
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Tile Printing 
Tile printing prints your entire scanned image on a series of pages when 
the image is larger than 8 X 10 inches. Tile printing starts at the upper left 
corner of the image displayed on screen and continues printing the entire 
image on separate pages. The pages may then be pasted or taped to
gether. Tile printing is ideal for creating posters. In most cases, you'll 
want to use the tile printing option. Due to memory allocation for print
ing, it is possible to create an image that is too large to print. 

To tile print: 
• Scroll the image to be printed so that the upper left corner of the area 

to be printed image is in the upper left corner of the screen. 
• Select Choose Printer ... from the File menu and select the desired 

printer. 
• Select Tile Print from the File menu (or press 0- T). 

The print dialog box appears. 
• Set the mode for printing. 
• Click on the OK button. 

ThunderScan GS will prepare the data for printing. Be patient, tile 
printing can take a while. Because of the nature of Apple's printer 
drivers, extraneous data is often printed to the right side of the image. 
This strip of printed area can be trimmed away with scissors. 

Printing an Image on One Page 
ThunderScan GS prints one screen width of an image per page, whether 
or not a reduction is specified in the page setup dialog box. To print an 
image on one page, you must scan at the appropriate DPI for the size of 
the original. To do this, adjust the DPI scroll bar until the view rectangle 
is approximately the same size (or slightly larger) as the width of the 
scan rectangle. 
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Quitting ThunderScan GS 
When you're finished using ThunderScan GS and want to leave the 
application, simply: 
• Choose Quit from the File menu (or press 0 - Q). 
• Click on the Yes button to exit ThunderScan GS. 

If you have not saved the current image, a dialog box will appear: 

Do you want to saue the 
current image? 

No 

Figure 3.9: The quit dialog box. 

( Cancel] 

• Click on the Yes button if you want to save the image. 
• Click on the No button if you don't wish to save your image or any 

changes might have made. 

Disconnecting the Scanner 
Whenever you leave ThunderScan GS, you should disconnect the scan
ner. Other software may not operate properly with the scanner con
nected. 

To disconnect the scanner: 
• Loosen the thumbscrews and unplug the scanner from the game 

port. 
• Remove the cartridge from your printer and insert a ribbon car

tridge. 
• Store the scanner in a safe place. 
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Keyboard Shortcuts 
O-B Contrast and Brightness 

O-C Copy 

O-F Filter 

O-N New Scan 

0-0 Open 

O-P Print 

O-Q Quit 

O-R Resume Scan 

0-5 Save 

O-T Tile Print 
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